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1 Wstep

Eclipse jest kompletnym srodowiskiem programistycznym wspierajaca wiele
jezykow programowania (C,C++, JAVA, PHP itd.). Srodowisko jest do-
stepne nieodptatnie i czesto na jego podstawie firmy tworza wtasne oprogra-
mowanie, przyktadem takiego komercyjnego produktu jest srodowisko At-
tolic dla mikrokontroleréw z rodziny ARM—Cortex. Zaleta §rodowiska pro-
gramistycznego jest integracja wielu narzedzi, ktoére sg dostepne w jednym
miejscu.

Zalety programu Eclipse z dodatkiem dla AVR:

e Automatycznie tworzenie Makefile - bardzo wygodne przy wiekszej ilo-
sci plikéw w projekcie.

e Kreator tworzenia projektu AVR - wybieranie podstawowych parame-
tréw z pozycji dostepnych na listach rozwijanych.

e Narzedzie IntelliSense - podpowiedzi funkcji, zmiennych w czasie pisa-
nia kodu wraz z pomoca do nich.

e Sprawdzanie poprawnosci kodu w trybie onnline - szybkie wykrywanie
literowek, braku drednikéw itd.

e Kompilacja i wgrywanie programu do mikrokontrolera za pomoca jed-
nego klikniecia.

e Duza popularnoéé oprogramowania - duza grupa uzytkownikow stuza-
cych pomoca.

Wymienione powyzej funkcje sa obecnie standardem w programowaniu z wy-
korzystaniem zaawansowanych $rodowisk programistycznych poniewaz bar-
dzo przyspieszaja proces pisania bezbtednego kodu programu. Pozwalaja
skupié¢ sie glownie na tworzeniu kodu aplikacji od strony funkcjonalnodci.



1.1 Instalacja

Pierwszym krokiem do rozpoczecia swojej przygody z mikrokontrolerami
AVR jest instalacja niezbednych narzedzi. Nalezy rozpoczaé od instalacji
kompilatora, bibliotek, plikéw nagtéwkowych dla poszczegédlnych uktadow.

1.2 Instalacja WinAvr

Sciggamy oprogramowanie ze strony: http://sourceforge.net/projects/
winavr/files/WinAVR/ i postepujemy zgodnie z kolejnymi krokami insta-
latora. Wszystkie sciezki najlepiej zostawi¢ bez zmian, pozwoli to uniknaé
probleméw konfiguracji kolejnych ktory aplikacii.



1.3 Instalacja Eclipse

Oprogramowanie pobieramy ze strony: http://www.eclipse.org/downloads/,
wybieramy wersje , Eclipse IDE for C/C++ Developers Eclipse IDE for C/C+-+
Developers”. Instalujemy oprogramowanie zgodnie z kolejnymi krokami in-
stalatora.

1.4 Instalacja dodatku AVR dla Eclipse

Sam program Eclipse nie jest przygotowany do programowania mikrokontro-
lerow AVR dlatego niezbedne jest doinstalowanie dodatku umozliwiajacego
programowanie (wymagane jest polaczenie z internetem). Uruchamiamy
program Eclipse i wybieramy (Help > Install New Software...) (Rys. 1)
w polu ,Work with” wpisujemy adres:
http://avr-eclipse.sourceforge.net/updatesite,

przyciskamy enter i po zatadowaniu zaznaczamy pole opcji ,AVR Eclipse
Plugin”.

Postepujemy zgodnie z kolejnymi krokami instalatora, w programie powinien
pojawi¢ sie nowy pasek narzedzi (Rys. 2). Od tej pory mamy przygotowane
cale srodowisko programistyczne i mozemy utworzy¢ swoj pierwszy projekt.



Available Software H
Check the items that you wish to install. ’

Work with:  http://avr-eclipse.sourceforge.net/updatesite -

Find more software by working with the "Available Software Sites” preferences.

type filter text
Version
(00 AVR Eclipse Plugin
Select Al | | Deselect All 1 item selected
Details
Show only the latest versions of available software Hide items that are already installed
[7] Group iterns by category What is already installed?

[ Show only software applicable to target environment
Contact all update sites during install to find required software

@ < Back Next > Finish

Rysunek 1: Instalacja dodatku AVR.

File Edit Source Refactor MNavigate Search Project  AVR  Run  Window Help

A AN - IR R SR RN A E RN C A Y R

[7 Project Explorer 53 = 8

Rysunek 2: Pasek narzedzi do programowania AVR.



1.5 Instalacja AVR8 Burn-O-Mat

Program stuzy do tatwej i w miare bezpiecznej zmiany ustawien dotycza-
cych fusebit-6w. Dodatkowo posiada opcje wgrywania/odczytywania do mi-
krokontrolera pliku w formacie ,.HEX”. Jest to graficzna naktadka na AVR-
DUDE, ktore jest domyslnie instalowane z pakietem WinAVR. Do dziatania
wymagana jest zainstalowana Java.

Oprogramowanie pobieramy ze strony:
http://avr8-burn-o-mat.aaabbb.de/avr8_burn_o_mat_avrdude_gui_en.
html

Po pierwszym uruchomieniu (Rys.3) nalezy skonfigurowa¢ program.

6 AVRS Burn-O-Mat v2

File Settings Help

AVR type |ATmega32 \v|| Fuses |

Flash

|C:'5Users".‘.“.fnjtek'\Duwnlnads\.ergx—nuht.hex |V|| File ‘ ‘Intel Hex

| Write H Read || Verify

EEPROM

|C:1User51.‘.".f0jtek'\D ownloads\turnigy-9e-copy-eeprom

Read

Rysunek 3: Gléwne okno programu AVRS Burn-O-Mat.

Z menu opcji wybieramy ,Settings”. W oknie (Rys.5).



ARBODE location

E:\J\VR\Win.l\vr\bin\avrdude.exe| \

alternative AVRDUDE configuration)ile

EAVRIWinAvnbin\avrdude.conf

AVRDUDE Opfions /_

Programmer usbasp (USBasp, hitp:iwww.fischl.delusbasp/)

Port {port can be entered directly if notin list)

["] disable auto erase for flash (-D)
[] disable fuse check {-u)

[] Exit specification (-E) [[] vCC will be left activated on exit {-E vcc)
["] reset will be left activated on program exit (-E reset)

additional options

Rysunek 4: Konfigurowanie programu AVR8 Burn-O-Mat.

W nowym oknie podajemy w polu ,AVRDUDE location” i ,AVR configura-
tion file” prawidtowsy $ciezke do ,avrdude.exe” i avrdude.conf”, ktoére znaj-
duja sie w katalogu bin w miejscu zainstalowanego WinAVR. Po prawidlo-
wych ustawieniach resetujemy program i ponownie wchodzimy do ,settings”.
Teraz powinnismy moéc wybraé¢ programator w opcji ,Programmer” - jedli
lista nie jest widoczna to oznacza, ze mamy zle ustawiong éciezke do pliku
savrdude.conf”. Wybieramy posiadamy programator i na jakim porcie pra-
cuje, zamykamy okno. Od teraz program AVR8 Burn-O-Mat jest gotowy do
pracy.



Konfiguracja fusebit-6w (Rys.) odbywa sie w edytorze w ktorym za-

read fuses | | write fuses | | verify fuses | | reset to default | |Mo-de: normaI|V|

Fuse Editor | Fuse Hex Editor | Brown out detection | Oscillator/Clock Options |

programmed Description

Oscillator options

EEPROM memory is preserved through the Chip Erase
Select Boot Size (see Table 82 for details)
Select Boot Size (see Table 82 for details)
Select Reset Vector

Brown out detector trigger level

Brown out detector enable

Select start-up time

Select start-up time

Select Clock source

Select Clock source

Select Clock source

Select Clock source

CEEEECO OO EE RS SR

hecked means programmed (bit =0}

unchecked means unprogrammed (bit=1)

Rysunek 5: Konfigurowanie fusebit.

znaczamy odpowiednie ustawienia, dodatkowo w zaktadkach mozna wybraé
gotowe ustawienia (np. zmiana sygnalu zegarowego z wewnetrznego an ze-
wnetrzny odbywa sie w zaktadce ,Oscillator/Clock option”).

Uwagall!
Reczne niewladciwe ustawienie fusebit-6w moze prowadzi¢ do
zablokowania mikrokontrolera.
Nalezy konfigurowa¢ fusebit-y bardzo ostroznie.




2 Pierwsze kroki

2.1 Tworzenie pierwszego projektu - konfiguracja

Po uruchomieniu programu Eclipse wybieramy (File > New > C Project lub
C++ Project) (Rys.6).

2 ue-+-kdipie T e

File | Edit Source Refactor Mavigate Search Project AYR Run Window Help

MNew Alt+Shift+M » ject with Existing Code l;
Open File... C++ Project
Close Ctrl+W C Project
= P
Clase Al CtrlsShiftewy | [ Project-
Save Cirl+s Convert to a C/C++ Autotools Project
Save As Convert to a C/C++ Project (Adds C/C++ Nature)
Save Al Ctreshiftes |85 Source Folder
Revert % Folder
é} Source File
Move.. [K7 Header File
| F2 [ File from Template
2] Refresh F5 & Class
Convert Line Delimiters To 4 o Task
Print... Ctrl+P 5 Other.. Ctrl+N
Switch Workspace 4
Restart
g2y Import..
2y Export...
Properties Alt+Enter
Exit

Rysunek 6: Eclipse - nowy projekt.

W polu ,,Project name” podajemy nazwe dla naszego nowego projektu i kata-
log zapisu. Nastepnie wybieramy (AVR Cross Target Application > Empty
Project), upewniamy sie, ze w prawym oknie mamy wybrane ,AVR-GCC
Toolchain” (Rys.7) i klikamy ,Next >".

W kolejnym oknie zaznaczam tylko opcje ,Relase” (Rys. 8) i przechodzimy
dalej.

Teraz wybieramy z listy na jakim uktadzie bedziemy pracowac i podajemy
jego czestotliwosé taktowania (Rys.9). Klikamy ,Finish”.



C Project
Create C project of selected type

(: Project name: | Testl >

Use default location

Location: | Ch\Dropbox\Programowanie\ AVR\Testl Browse...

Choose file systern: | default =

Project type: 'W_—_"\

( AVR-GCC Toolchain

@& Empty Project
ey 3 ibrary

4 = Executable
@ Empty Project
@ Hello Werld AMSI C Project
[» [= Shared Library
[ (= Static Library
[ (= Makefile project

Show project types and toolchains only if they are supported on the platform

Rysunek 7: Eclipse - wybdr nazwy i rodzaju projektu.
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Select Configurations

Select platforms and configurations you wish to deploy on

Project type: AVR Cross Target Application
Teolchains: AVR-GCC Toolchain

Configurations:

[l & Debug Select all
3 Release
Deselect all

Advanced settings...

Use "Advanced settings” button to edit project's properties,

Additicnal configurations can be added after project creation.
Use "Manage cenfigurations” buttons either on toelbar or on property pages.

Rysunek 8: Eclipse - wybor trybu projektu.
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AVR Target Hardware Properties
Define the AVR target properties

MCU Type: ATmega32

MCU Frequency (Hz): 1000000

Rysunek 9: Eclipse - wybo6r mikrokontrolera i czestotliwosci taktowania.
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W lewym oknie utworzyt sie nowy projekt. Teraz nalezy ustawié¢ jeszcze
programator, w tym celu klikamy prawym przyciskiem myszy nazwe nowego
projektu i wybieramy pozycje ,Properties”. Nastepnie wybieramy (AVR >
AVRDude). W nowym oknie (Rys.10) z listy rozwijanej wybieramy uzywany
programator. Jesli nie mamy na lidcie naszego programatora to klikamy przy-
cisk ,Edit” i tworzymy nowa konfiguracje.

= Properties for EDU-DS13:

ype filter tet AVRDude et

» Resource

Vel AVRDude c [Release [ Active] ~] [Manage ¢ ]
Target Havd\%ve
[,

» C/C++ Build @ Programmer | @ Flash / EEPROM | @ Fuses Lockbits Advanced | @ Other!
) C/C++ General

Project References i) eniguration

Run/Debug Settings Jusbase - D
» Task Repository

WikiText

JTAGICE BitClack

Specify the bit clock period in microseconds for the JTAG interface or the ISP clock (ITAG ICE only)
Setthisto > 1.0 for target MCUs running with less than 4MHz on 2 JTAG ICE.
Leavethe field empty to use the preset bit clock period of the selected Programmer.

JTAGICE bitclock s

EitBang Programmer Bit State Change Delay

Specify the delay in microseconds for each bit change on bitbang-type programmers.
Set this when the the host system is very fast, or the target runs off 2 slow clock
Leavethe field empty to run the ISP connection at max speed,

Bit state change delay os

®

Rysunek 10: Eclipse - wtasciwosci, ustawienie programatora.

W zakladce , Target Hardware” (Rys.11) mamy ponownie mozliwos¢ wy-
boru/zmiany mikroprocesora jak i wyboru czestotliwosci.
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type fifter text

» Respurse
AVR
AVRDude
[Target Hardware |
Builgers

b C/Ces Build

b C/C++ General
Project References
Run/Debug Settings

1 Task Repository
WikiText

Target Hardware

Configuration: |Rele

MCU Type [ATmega32

ICU Clock Frequency 8000000

~] [Load from MCD

Manage Configurations...

Copy Project Settings | | Restore Defaults Apply

Rysunek 11: Eclipse - wlasciwosci, wybo6r mikrokontrolera i czestotliwosci

taktowania.
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2.2 Tworzenie programu — pisanie kodu

Mamy juz gotowy projekt do pracy. Teraz musimy utworzy¢ pierwsze pliki w
ktorych bedzie nasz kod programu. Piszac program nalezy staraé sie dzielié¢
kod na poszczegolne modulty umieszczone w osobnych plikach (na wzér pro-
gramowania obiektowego — klasy). W lewym oknie klikamy na nazwe naszego
projektu i wybieramy ,New” a nastepnie typ pliku jaki chcemy utworzy¢.
Najlepiej zawsze tworzy¢ pary plikow ,Header File” i ,Source File”. W pliku
nagtowkowym (Header) dokonujemy definicji nagtowkow funkeji zmiennych
globalnych, importujemy dodatkowe biblioteki. Natomiast w pliki ,source”
implementujemy kod funkcji, kod programu. Pierwszymi plikami jakie na-
lezy utworzy¢ sa ,main.h” i jmain.c”. W pliku ,main.c” tworzymy funkcje
startowa "int main() ...”.

Pisanie kodu w $rodowisku Eclipse jest bardzo przyjemne. Srodowisko
na biezaco sprawdza poprawnosé naszego kodu i w razie literéwek podkresla
na czerwono bledy. Dodatkowa zaleta jest funkcja podpowiadania. Wystar-
czy wpisaé kilka poczatkowych liter zmiennej, funkcji a rozwinie sie lista z
podpowiedziami.

Porada
Jedli lista nie rozwija sie automatycznie to mozna wymusic jej
rozwiniecie przez przycisniecie kombinacji klawiaszy ,,CTRL + SPACE”.

2.3 Kompilacja i wgrywanie do mikrokontrolera

Jak mamy juz gotowy program to nalezy go skompilowaé ikona przedstawia-
jaca mlotek (Rys.12).

.;';E_,

Rysunek 12: Eclipse - ikona kompilacji projektu.

Jedli projekt nie zawiera bledéw to w dolnym oknie - konsola pojawi sie
komunikat o zakoriczonej kompilacji z sukcesem (Rys.13). Jesli projekt na
bledy nalezy je poprawi¢, przed préba wgrania projektu do uktadu.
Do wgrywania projektu stuzy ikonka z zielona strzalka i napisem ,AVR*”
(Rys.14). Postep wgrywania pokazywany jest w konsoli i jesli nie wystapity
btedy to po chwili mamy wgrany nowy program do naszego uktadu.
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Inveking: Print Size
avr-size --format=avr --mcu=atmega32 EDU-D51387.elf
AVR Memary Usage

Device: atmega32

Program: 2972 bytes (9.1% Full)
(.text + .data + .bootloader)

Data: 48 bytes (2.8% Full)
(.data + .bss + .noinit)

Finished building: sizedummy
15:81:53 Build Finished (tock 25.328ms)

Rysunek 13: Eclipse - kompilacja zakoriczona sukcesem.

AYR
"I

Rysunek 14: Eclipse - Tkona wgrywania projektu do mikrokontrolera.

Uwagalll
Jedli pojawiaja sie bledy przy wgrywaniu programu nalezy sprawdzi¢
poprawnodé podlaczenia programatora, zasilania. Jesli wszystkie
potaczenia sa prawidlowe to nalezy odtaczyé¢ programator od portu
USB i ponownie podtaczy¢.
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2.4 TImport projektu

Wazna kwestia jest otwieranie projektu, ktéry zostal wczeéniej zrobiony.
W Eclipsie zaleca sie dokonywaé tej operacji przez importowanie projektu,
dzieki czemu mamy gwarancje, ze program zataduje wszystkie ustawienia
projektu a nie tylko same pliki. Importowanie projektu polega na wskazaniu
katalogu na dysku zawierajacego nasz projekt.

Wybieramy ,File->Import” w otwartym oknie (Rys.15) wybieramy opcje
LExisting project in Workspace” i klikany , Next >7.

Select

Create new projects from an archive file or directory.

Select an import source:

type filter text

" e PITE
[ Existing Projec@ntoW@

=, Preferences
> 2= C/C+s
s = CVS
s = Git
= = Install
» = Remote Systems
» = RPM
» [ Run/Debug
» [ Tasks
» = Team
» = Tracing

Rysunek 15: Eclipse - Wybieranie typu importu.

Teraz wybieramy ,Browse” i odszukujemy katalog z naszym projektem
(Rys.16). Po wybraniu poprawnej lokalizacji w oknie ponizej zladuje sie
nam wybrany projekt. Klikamy ,Finish” i mozemy przystapi¢ do pisania
programu.
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Import Projects
Select a directory to search for existing Eclipse projects.

@ Select root direclgry:  C:\Dropbox\Programowanig AVR\EDU-PCF857

(7) Select archive file: | T ——,

Projects:

EDU-PCFE5T4 (CADropbox\Programowanie\ AVRNEDU-PCFBSTA Select All
Deselect All

[7] Copy prajects into workspace
Working sets
[7] Add project to working sets

Waorking sets: Select...

Finish || Cancel

Rysunek 16: Eclipse - Wybieranie lokalizacji projektu do importu.
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3 Dodatki

3.1 Wykorzystanie typu float w funkcji ,,sprintf”

Gdy chcemy wykorzysta¢ zmiennie typu float, double w funkcji ,sprintf”
nalezy poinformowaé kompilator o takiej potrzebie. Jesli kompilator nie
dotaczy dodatkowych bibliotek to zamiast liczby pojawi sie znak ,,7”. Do po-
prawnego wys$wietlania zmiennych zawierajacych liczby z przecinkiem kom-
pilator musi doda¢ dodatkowe biblioteki do naszego projektu - zwieksza to
kod wynikowy aplikacji.

type filter text Settings S
+ Reource L
» AVR
G [Release [Active] ~| [Manage
BT hiables

Discovery Options & Tool Settings | & Build Steps | ' Build Artifact | [ Binary Parsers | @ Error Parsers|
Environment

(2 Additional Tools in Toolchain | Map Filename  §{BuildArtifactFileBaseName.map
% 7 Editor

S
4 1) AVR Assembler 5 it symbols ()

(2 General

e General 3 Paths 7] No startup o default ihskeagstdiib)
Project References (2 Debugging Other Argument: w
Run/Debug Settings 4 18 AVR Compiler

. Task Repository 2 Directories
WikiText 2 Symbols

£ Warnings

£ Debugging

2 Optimization

£ Language Standard
53 Miscellaneous

4 I AVR C++ Compiler

¥ Directories

5 Symbols

5 Warnings.

3 Debugging

2 Optimization

£ Language Standard
5 Miscellaneous

inker
5

% General

= 1

i Objects

4 B AVR Create Extended Listing
(2 General

4 B AVR Create Flash image
(3 General

4 B AVR Create EEPROM image
(2 General

4 B Print Size
(53 General

ne

Restore Defaults Apply
®

Rysunek 17: Eclipse - Konfiguracja funkcji ,sprintf” do obshugi liczb typu
float.

Wchodzimy do wlasciwosci projektu i wybieramy ,,C/C++ Builder” ->
Settings” ->  AVR C++ Linker” ->  General” i w polu ,,Other Arguments”
wpisujemy: ,~-W1-u,vfprintf” (Rys. 17). Nalezy doda¢ jeszcze dwie biblio-
teki:  libm.a” i Jibprintf flt.a”. Wybieramy ,C/C++ Builder” ->  Settings”
-> AVR C++ Linker” -> Libraries” i dodajemy nowe biblioteki przy uzyciu
przycisku z plusem. W nowym oknie wpisujemy ,m”, powtarzamy czynnosé¢
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i tym razem wpisujemy ,printf flt” (rys. 18). Eclipse zostal poinformowany,
ze ma dodawaé¢ dodaé do projektu podane wczesniej biblioteki. Po tym
zabiegu nalezy dodatkowo wybra¢ z listy projektu opcje ,Clean Project” a
nastepnie ,Build Project”.

[ = properties for EDU-Cnewi

type filter text Settings -
» Resource
» AVR
B c [Release [Active] ~] [Manage ¢
Discovery Options & Tool Settings | # Build Steps | ' Build Artifact | [} Binary Parsers | @ Error Parsers|

Environment.

(2 Additional Tools in Toolchain
4 ) AVR Assembler

Libraries (- a8 8 E

in Editor (2 General
I C/C++ General (2 Paths
Project References (2 Debugging
Run/Debug Settings 4 & AVR Compiler
» Task Repository ¥ Directories
WikiText £ Symbols
5 Warnings

i Debugging

B Optimization

2 Language Standard
E Miscellaneous

4 I AVRC++ Compiler

5 Directories
 Symbols

5 Warnings

%52?“9_9‘19 Libraries Path (-1 aa sl e
5

% Language Standard

5 Miscellaneous
4 53 AVR C++ Linker
32 Cere

|2 Libraries|

—
4 1) AVR Create Extended Listing
(2 General
4 ) AVR Create Flash image
(5 General
4 1) AVR Create EEPROM image
(2 General
4 B Print Size
(8 General

Restore Defaults Apply
®

Rysunek 18: FEclipse - Konfiguracja funkcji ,sprintf” do obshtugi liczb typu
float.
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